# TABLE OF CONTENTS

- **Introduction** ........................................................................................................... 7

- **Your role in the Hendrix website** .................................................................................... 7

- **Orientation** .................................................................................................................... 8

- **Parts of a web page** ........................................................................................................ 8

- **Page Content** ................................................................................................................ 8

- **Section Menu** .................................................................................................................. 8

- **Header and Footer** .......................................................................................................... 8

- **Types of Content** ............................................................................................................ 8

  - **Content** ......................................................................................................................... 9

  - **Forms** ............................................................................................................................ 9

  - **Assets** ........................................................................................................................... 9

  - **Smartforms** .................................................................................................................. 9

  - **Library Items** ............................................................................................................... 9

  - **Hyperlinks** ................................................................................................................... 9

- **Groups of Content** ........................................................................................................ 10

  - **Menus** .......................................................................................................................... 10

  - **Collections** ................................................................................................................ 10

  - **Taxonomies** ............................................................................................................... 10

- **Accessing Ektron** ........................................................................................................ 10

  - **Username and Password** ............................................................................................. 10

  - **Logging In** .................................................................................................................. 11

- **The Ektron Dashboard** ................................................................................................ 12

  - **Search Filters** ............................................................................................................. 13

  - **Saving Searches** ......................................................................................................... 13

- **The Ektron Workarea** .................................................................................................... 13

  - **Content Tab** ................................................................................................................. 14
Figure 1 - What is this Box? .................................................................................................................. 7
Figure 2 – Isn’t this the same as logging into CampusWeb? ........................................................................... 10
Figure 3 - What if I don’t see a “New” button on the menu in the right pane? ......................................... 16
Figure 4 - Why does my content block have a “(1)” in the title when I publish it? ..................................... 17
Figure 5 - What’s the difference between Manual and Automatic Aliases? .................................................... 18
Figure 6 - Why do I need to put my site name and then a slash before my short URL? ............................... 18
Figure 7 - What are Active and Primary states for Manual Aliases? .............................................................. 19
Figure 8 - Why can I see bold and italic, but I can’t find underline? ............................................................. 22
Figure 9 - Is there anything I should avoid when formatting my text? ......................................................... 22
Figure 10 - What’s the difference between a paragraph and a line-break? or How can I single space my content? 22
Figure 11 - What if I want to create my content in another program like Word and then paste it into the editor? 23
Figure 12 - I want to use multi-lingual content. How does the system deal with different languages? ........ 24
Figure 13 - Should I start my content item with a heading? ......................................................................... 25
Figure 14 - What’s a recognized URL? ........................................................................................................ 25
Figure 15 - Can a page have too many hyperlinks? ...................................................................................... 26
Figure 16 - Is using tables really that bad? .................................................................................................. 27
Figure 17 - Should I resize pictures in the content editor? ............................................................................ 28
Figure 18 - Why use the class names instead of the text-alignment tools for image alignment or the cool things I found in the “Advanced” tab you didn’t talk about? ................................................................. 29
Figure 19 – Can I upload a 30 megapixel, 4 GB image for my webpage? .................................................... 32
Figure 19 - What if I don’t see an “Edit” button on the menu in the right pane? ........................................... 33
Figure 20 - How can I send an email to someone who submits a form? What if I want to make sure the email’s “from” address is the person who submitted the form? ................................................................. 39
Figure 21 - What if I don’t see a “New” button on the menu in the right pane or there is no “Folder” option on the “New” menu? ................................................................................................. 41
Figure 22 - What happens if delete a folder? ................................................................................................. 41
Figure 23 - When do changes to menus show up on the website? ............................................................... 42
Figure 24 - Can I use <fill in the blank advanced content item> on my website? ........................................ 44
Figure 25 - Do web calendar events show up on the Master Calendar? Do Master Calendar events show on my web calendar?  

........................................................................................................................................................................................................................................44
INTRODUCTION

This guide is designed to give you a brief overview of the Hendrix website and the Ektron content management system that we use to manage all of the content of the website. This is not meant to be exhaustive documentation of the system or the website in general. The official documentation for the system is almost 3,000 pages long and covers everything you could ever want to know. If you are interested in looking at it, contact IT.

YOUR ROLE IN THE HENDRIX WEBSITE

The Hendrix website is a large and complex application that is built from many small pieces. Each piece is in turn built from content created and managed by site owners that is combined with special style and display information that is pre-defined by the Hendrix HelpDesk.

Because the website is so large and complicated it is up to you and your team to ensure that your information is as up-to-date and meaningful as it can be. You are the most critical part of the Hendrix website. Without the content that you put on the site it is simply an attractive frame.

Our goal in this training is to give you the tools you need to make almost any change to your website that you would need and to give you information on how we can help you create the rest.

You are the most critical part of the Hendrix website. Without the content that you put on the site it is simply an attractive frame.

Figure 1 - What is this Box?

Boxes like this one in this documentation will be used to present the answers to frequently asked questions and common problems related to the task you are working on. They are frequently hilarious, much like the rest of this documentation.
ORIENTATION

This section of the guide aims to familiarize you with the pieces of the Hendrix website and the Ektron content management system. This is meant as an overview; each of these pieces will be covered in greater detail in later sections.

PARTS OF A WEB PAGE

1) Page Content 2) Section Menu 3) Header 4) Footer

Standard web pages on the Hendrix website are composed of several large pieces:

1. page content
2. section menu
3. header
4. footer

Of these four pieces, you are primarily only concerned with the page content and the section menu.

PAGE CONTENT

The page content is a content block or form block in the Ektron system. Each “page” in your site will consist of a single piece of content.

SECTION MENU

The section menu is a menu in the Ektron system. You will generally only have one menu for your website that is displayed with all of your pages.

HEADER AND FOOTER

The header and footer are pre-defined sections of the page that are loaded by your template that is created for you by the HelpDesk. These sections are consistent throughout the Hendrix website and cannot be changed.

TYPES OF CONTENT

There are several different types of content stored in the Ektron content management system. Each of the different types is used for different purposes and in combination they form all of the different types of pages on the Hendrix website.
CONTENT

Content blocks (also known as HTML Content) are used to display any type of basic web page content and is equivalent to a single page on the website. The title of the content block will appear in the page title, the breadcrumb in the header and as the title of your page in large font. Content blocks make up the bulk of the content on the website.

FORMS

Form blocks (also known as HTML Form/Survey) are used to display user interactive forms, polls and basic surveys. They are slightly more complicated than content blocks but can be used to create email messages and to generate reports of user information. These are commonly used for “contact us” forms, registration forms and any other page on the website where we are requesting simple information.

ASSETS

Assets are pictures, documents, and multimedia files that have been uploaded to the system as a type of content. These items are generally considered content in their own right, for example: pictures from events, pdf forms for the business office, video files of lectures, etc. This type of uploaded file is different from the next type of content.

SMARTFORMS

Smartforms are a special type of content that requires the content creator to fill out a special form that is then used to generate complex content on the website. An example of smartform content is the calendar event for the Public events calendar.

LIBRARY ITEMS

Images and files that are uploaded as library items are not content in their own right. They are things like small graphics used on a page for a graphical title and pictures of individuals that could not be considered complete on their own (like a staff photo). In general these items cannot stand by themselves as content. They cannot be moved in the system if the content they are related to is moved to a new location and can never be made searchable.

HYPERLINKS

The system can store commonly used hyperlinks as content so that every place we have used a hyperlink in the site can be updated all at once. For instance if you were linking to a form on a government website (such as the FAFSA form) from multiple pages and the URL for that form changed, you could update this hyperlink item once and it would be fixed in all locations you used it.
GROUPS OF CONTENT

There are several different ways to create groups of content in Ektron and they all have slightly different purposes.

MENUS

Menus are hierarchical collections of content that are used to display navigational menus on the website. The section menu and primary navigation in the header are examples of menus on the website.

COLLECTIONS

Collections are flat collections of content that are used to group related content for use. An example of this is the content collection that is used on the Hendrix homepage to generate the “News & Events” section.

TAXONOMIES

A taxonomy item is a complex, hierarchical organization of content items, similar to a menu, which is used to categorize content.

ACCESSING EKTRON

To modify or create content on the Hendrix website, you will need to log in to the Hendrix website.

Figure 2 – Isn’t this the same as logging into CampusWeb?

This is exactly the same process as logging in to CampusWeb, so if you are familiar with that, go ahead and skip this section. And great job noticing!

USERNAME AND PASSWORD

To open the Ektron system, you will need to log in to the Hendrix website.

If you are a faculty or staff member your username is your email address. Your password is the password you use when logging in to your computer or email. For example John Smith would use his email address “smith@hendrix.edu” and password “123password” (which is a terrible password).

If you are a student worker, you will use the student worker login information given to you by your supervisor. Your regular student account will allow you to log in to the website but will not give you access to Ektron.
LOGGING IN

1. Go to any page on the www.hendrix.edu website and click the login button at the top of the page.

2. Enter your email address and password and press the “Sign in” button.

3. You are now logged in to the website.
THE EKTRON DASHBOARD

The dashboard allows quick access to your content and is a great tool for finding pages without having to manually look through the workarea.

To open the dashboard:

1. Click the “Ektron” logo on the top left of the Ektron Editor menu.

2. Click where it says “Dashboard”. You should see something amazing like this:

The dashboard allows you to search through all the content in the site that you have access to, and shows you at a glance its properties and status. You can also open the content for editing directly from the dashboard.

There are two awesome things to know about using the dashboard:
SEARCH FILTERS

On the left side of your search results you should see a list of filters. These will allow you to limit your content by the properties they share and is exactly the same as when you are on Amazon searching for “athletic shoes” and you narrow your results by clicking on the “brand” filter “skechers” to reduce the amount of shoes to a smaller number that are more in line with what you want to buy. Sometimes you may narrow your search too much and get completely incorrect content (like when you click “ray-ban” in the example above instead of “skechers”, which is ridiculous). In that case simply uncheck a few filters and you should be back to a more reasonable list.

SAVING SEARCHES

Once you have your content searched and filtered the way you like it for your purposes, you can save the search by clicking the “Save” button on the top right of the area and a new tab will appear in your dashboard.

**Figure 4 – Why would I ever access my content any other way than using the dashboard?**

Right?

Well there are a few things you can’t do in the dashboard that you may need to do such as creating new content, and editing collections or menus, but I would definitely use the dashboard most of the time. It’s just easier.

THE EKTRON WORKAREA

The workarea is the web application we use to access the content stored in Ektron.

Once you have logged in, you should now see the “Welcome Bar” and the Ektron editor menu at the top of the page. Click “Workarea” to launch the Ektron workarea.

Once you open the workarea, click the “Content” tab on the top left to view content in the system.
CONTENT TAB

The content tab contains all content blocks, form blocks, assets, menus, collections, taxonomies and smartforms. It is where you will do all of your content creation and editing, and where you will spend most of your time in the system.

FOLDER LIST

On the left of the content tab you will see a list of folders. These folders are generally organized by content owner and are grouped into logical sections of the website, though they do not always reflect the navigation structure of the web pages on the Hendrix website.

Clicking a folder’s name in the list will open the folders contents in the pane on the right. In the image above the content for the “Folders” folder is listed in the right pane.

Clicking the plus sign next to a folder’s name will expand the folder to show any sub-folders below it.
MENUS, COLLECTIONS, AND TAXONOMIES

Below the folder list you may see several buttons labeled “Menus”, “Collections”, and “Taxonomies”. These buttons will slide up and replace the folder list with a list of the content group item you selected. This is the easiest way to edit a menu, collection or taxonomy. Similar to the folder list, when you click on an item in the left pane, the contents of that item will load in the right pane.

FILTERING

When you are viewing the content of a folder, you will only see the first 50 or so items in the folder in the right pane. At the bottom of the pane is a series of buttons that will allow you to go to the next page of results. If you are looking for a specific type of content, such as content blocks or form blocks you can click the “View” button on the menu above the right pane and select the specific type of content you wish to see.

LIBRARY TAB

The library tab looks very similar to the content tab and has the exact same folder structure. The only content in the library tab are library items. You can use the library tab to add, edit, or delete library items.

REPORTS TAB

This tab provides access to several reports that give you more information about your content in the system.

HELP TAB

The help tab will provide you with the full, exhaustive reference of help files for the Ektron system. By clicking on the tab you can view all of the items in the help reference. Alternatively any time you see the help icon (__) you can click it for help related directly to the area of the system you are using. This context sensitive help is by far the easiest to use.
WORKING WITH CONTENT

Now that you are familiar with the workarea we can get to the nuts and bolts of building and editing content.

CREATING CONTENT

To create HTML Content:

1. Log in and go to the workarea.
2. Click “Content” on the top left to open the content tab.
3. Use the folder list to find the folder where you want to create your content.
4. Once you are in the folder you want to create your content in, click “New” ➔ “HTML Content” in the menu in the right pane to create a new content block.

Figure 3 - What if I don’t see a “New” button on the menu in the right pane?

If you don’t see a “New” button, you may not have permission to edit content in this folder. Contact the web team for more information.

THE CONTENT EDITOR

After you create the content block, it should immediately open in the content editor. The content editing window looks like this:
The content editor has several major sections, the content Title field, the content properties tabs, and the “what you see is what you get” (WYSIWYG) editor.

**CONTENT TITLE FIELD**

The title of your content block appears in several places on a web page:

- In the page title that appears on the web browser window and bookmarks to your web page
- In the breadcrumbs in the header
- Above your content on your webpage in large font
- Additionally the title of your content is automatically entered as the text of a menu item when you add it to a menu, though it can be changed

Content titles must be unique within a folder and should be descriptive as they are used by search engines (such as Google and the Hendrix site search) to classify the importance and relevance of your webpage.

---

**Figure 4 - Why does my content block have a “(1)” in the title when I publish it?**

If a piece of content already exists in the folder you are working in that has the same name as your content item, Ektron will automatically add the “(1)” to the end of the content’s title to ensure that the title is unique and to remind you to be creative.

If you can’t find the other piece of content with the same name, check the library for uploaded images or files that have the same name.

---

**CONTENT PROPERTY TABS**

The Ektron system stores more information about your content than is displayed in the page content section of a web page. The tabs above the content editor provide access to several of these additional properties.

**SUMMARY**

The summary tab is exactly what it sounds like. It is a summary of the information in your content item. If you leave it blank, the system will automatically fill it with text from the top of your content item. This sometimes caused problems if you content contains a table, list of links, or images. We recommend that you put something meaningful in this box as it is used for the summary displayed on the Hendrix site search and in any collections the content gets added to.

**METADATA**

The metadata tab contains special information about your content. You probably won’t use it unless you are doing specialized things such as mapping or an employee profile. We may begin to use metadata more often in search results to create search filters for our content similar to the amazing dashboard.
ALIASES

By default whenever you publish a piece of content in the system, the URL to access it is something like “www.hendrix.edu/foldername/templatename.aspx?id=123456”.

This works just fine for a web browser or a robot but is harder to tell to a person or publish in a document or email. The alias property lets you create shorter URLs that will still direct your viewers to your content item. There are two different interfaces for creating and managing aliases for content, depending on whether the content is new (has never been published) or is an existing piece of published content.

**Figure 5 - What’s the difference between Manual and Automatic Aliases?**

Manual aliases are created individually by you, the content author, for each piece of content. They are special and unique.

Automatic aliases are created using a pattern such as “foldername/content_title_with_underscores” and are set up by site administrators for large amounts of content such as newsreleases. These URLs are generally less human readable than manual ones but still increase the ability of visitors to find your content via search engines.

If you are interested in creating an automatic alias, please contact HelpDesk@hendrix.edu for more information.

**To create a manual alias for new content:**

1. Click the “Alias” tab on the content properties tabs.
2. In the “Add Manual Alias” box, put your site name, a slash, and then the short URL you want to use. For example to create a short link in the HelpDesk website you would enter something like “HelpDesk/training”. Please be sure that you put your site name first and then the slash.
3. Select the “/” in the dropdown next to the “Alias” box.
4. Publish your content to create the alias.

**Figure 6 - Why do I need to put my site name and then a slash before my short URL?**

If you don’t put your site name and the slash, you are putting your alias immediately after the “www.hendrix.edu” part of the address.

Doing it this way is not necessarily wrong, but if you want to have a URL at that level, please contact the web team first as you could be overriding other important content on the website.

Additionally we may at some point have to take your alias away from you if the greater College website needs it. For instance, you cannot have the alias “www.hendrix.edu/Bill” because that belongs to the president.
To create a manual alias for existing content:

1. Edit your content item and click the “Alias” tab on the content properties tabs.
2. You should see a list of all manual aliases currently assigned to your content item.
3. Click “Add Manual Alias” to open the “Alias Data” box.
4. In the “Alias” box under “Define Url”, put your site name, a slash, and then the short URL you want to use. For example to create a short link in the HelpDesk website you would enter something like “HelpDesk/training”. Please be sure that you put your site name first and then the slash.
5. Be sure to select the “/” instead of “.aspx” in the dropdown list below the “Alias” box.
6. Check the “Active” checkbox to activate this new alias.
7. If you want the new alias to be the default alias, check the “Primary” box as well.
8. Click “Save”

Figure 7 - What are Active and Primary states for Manual Aliases?
The “Active” checkbox allows you to turn off an alias without deleting it. The “Primary” checkbox allows you to set one of the aliases as the primary alias that all the others will get redirected to. This allows you to have one “main” alias and several “redirection” aliases.

SCHEDULING CONTENT

The schedule tab allows you to set a date and time for your content to expire as well as telling the system what to do with expired content. There are three options for expired content:

- **Archive and remove from site.** This moves the content into a special archive section and makes it unavailable on the website.
- **Archive and remain on site.** This moves the content into a special archive section but leaves it available on the website.
- **Add to the CMS Refresh Report.** This places the item on a report in the reports tab that lists all content that is out of date.

To schedule content to expire:

1. Click on the “Schedule” tab of the content properties tabs.
2. Select an “End Date” with the calendar control provided.
3. Choose an action for the system to take on the end date.

THE CONTENT EDITOR

The content editor works similarly to most word processing software (like Microsoft Word). To create your content, enter text into the large box, then use the editor to apply formatting to your content such as bolding, hyperlinks and applying headings.
THE ALOHA EDITOR TOOLBAR

When you begin working with a piece of content the editor will appear exactly like your content.

The Aloha editor is a context-sensitive editor, meaning that it will offer editing options specific to the part of your content that you are editing.
At the top of your content you will see the tool bar, which has several important parts to highlight with boxes and arrows:

1. **Toolbar Tabs** – There are several tabs which may appear depending on the situation, but the three basic tabs are the Format tab for text editing, the Insert tab for inserting pictures and hyperlinks, and the review tab for modifying the HTML (if you are brave) and opening the Inspector.
2. **Text Format area** – Allows you to format text with basic formatting options.
3. **Style Selector area** – Allows you to apply a style to a selected piece of text.
4. **Library** – Allows you access to the library for inserting images, files, and links.
5. **Insert Embedded Media** – to insert things like YouTube videos.
6. **Pick Special Characters** – which does exactly what it sounds like.
7. **Inspector** – a multipurpose window that does everything (see below).
8. **View Source** – opens your content’s HTML to allow you to edit it directly.

**THE INSPECTOR**

This context-sensitive window float above your content when you open it and will contain options to edit and modify elements as they are clicked on in the main content editor window. It does a tremendous amount of things that we will talk about as they come up in the topics below.
The content editor will allow you to format text similar to most word processing software: select the text you want to format, and then click the format button (like “bold” or “italic”). There are formatting options for text-style, creating bulleted- and numbered-lists, sub- and super-script, and text alignment and indentation.

If you aren’t sure what a button will do, mouse over it and you should see a tooltip appear that describes the button. Or just click it and see what happens. Be bold (or italic)!

**Figure 8 - Why can I see bold and italic, but I can’t find underline?**
Because it’s intentionally missing!

You should never use underline formatting on a webpage because it appears to the user that you have a broken hyperlink.

Any grammatical situation that calls for an underline can be replaced with italics [citation needed].

**Figure 9 - Is there anything I should avoid when formatting my text?**
Tons of things, but the most important thing to remember is that most text-style formatting should only be used to highlight important items. Yes, all content is important, but if you bold all of the text then none of it stands out and you haven’t accomplished the goal of highlighting importance. When it comes to text-styles, less style is always better.

**Figure 10 - What’s the difference between a paragraph and a line-break? or How can I single space my content?**
Paragraphs on the internet are discrete blocks of content that all share the same basic formatting and have a double space between them. When you hit the “Enter” key in the content editor, it will close the current paragraph you are working on and open a new one.

When you hit the “Shift” and “Enter” keys together you will insert a line-break into the paragraph you are currently editing. The line-break will simply move the cursor to the next line without closing the paragraph.

This can cause problems when you are formatting an item like a heading because it will convert the entire paragraph to the new heading style, regardless of what you select on the page.

In general we don’t recommend using line-breaks unless you have a really good reason.
SPECIAL CHARACTERS

If you want to use special characters in your content (anything not on your standard keyboard) please use the built-in character map found in the “Pick Special Characters” button on the “Insert” tab.

The reasons to do this are twofold:

1. It’s much easier than trying to find the character somewhere else and then paste it in.
2. Using this character map will embed a special HTML code which will ensure the character gets properly displayed on a site visitor’s browser.

I’m sure you’ve visited webpages in the past and seen the □ character displayed in odd places. This is the dreaded “unknown character” symbol, and it appears when the web browser can’t figure out what to put in the place of a special character.

Special characters include all of the symbols as characters such as © and ™ as well as characters that represent accented letters such as the é in résumé.

To insert a special character from the Character Map:

1. Place the cursor where you want your special character.
2. Click the “Insert” tab on the Aloha toolbar.
3. Click the character map icon that looks like the Ω character (which is also a special character).
4. Click the special character you want to insert to insert it.
ABBREVIATIONS

The Aloha editor supports a new feature in HTML 5 (the newest version of the language which defines webpages) called the abbreviation tag. Using this allows a site visitor to interact with an abbreviation in text and instantly see what the abbreviation stands for.

To insert an Abbreviation:

1. Type your abbreviation text.
2. Select your abbreviation text.
3. Click the ab. button on the Text Format area of the toolbar.
4. Enter the text you want your abbreviation to represent.

HEADINGS

If your content is particularly long, it can help your viewers if you break it up with headings. Headings give visual hierarchy to a page and will allow a user to more quickly find the content that is most important to them. Remember, no one wants to read a wall of text (and they won’t).

To apply a heading style to a paragraph of text:

1. Click on the paragraph you want to style (you don’t have to select it).
2. Click the heading you want to use in the Style Selector Area. You may have to click the down arrow to show Heading 3, etc.

To convert a heading to normal text:

1. Click on the heading you want to style (you don’t have to select it).
2. Click the Paragraph style in the Style Selector Area.

When you apply a heading style, it will always affect the entire paragraph of text it is in. For this reason it is best to type your text in first, then hit enter to close the paragraph, and then apply the heading.

Figure 12 - I want to use multi-lingual content. How does the system deal with different languages?

Ektron actually supports creating separate language versions of each content block. Combined with a language selection tool on your webpage, we can create entirely different versions of your content.

If you are doing simple content translation, you can use the “Machine Translation” tool, but we recommend you get a native speaker to proofread or even re-write your content.

If you are interested in multilingual content, contact the web team.
HYPERLINKS

One of the most important advantages of webpages over printed text is the ability to link related items with hyperlinks. If you are typing your content into the editor directly, it will attempt to create hyperlinks to email and web addresses when it recognizes them.

To create a hyperlink to an email address or external website from a recognized URL:

1. If the URL starts with www or http or is an email address like HelpDesk@hendrix.edu, the editor will automatically create a hyperlink for the text once you hit the space bar after the text or punctuate the sentence. Otherwise:

   Figure 13 - Should I start my content item with a heading?

   No.

   Remember that your content item will not appear on the webpage by itself. It will be placed into the page content section of the webpage and the content title will appear as a large heading immediately before your content block. If you put a heading at the top of your content item, there will be two large headings on your webpage which is needlessly confusing and often repetitious.

   For the same reason it’s never a good idea to go to crazy with headings, as the repetition will cause them to lose their importance.

Figure 14 - What’s a recognized URL?

This is a made up phrase for “a piece of text that the editor recognizes as a URL” (hence the clever term for it).

More specifically, it’s a piece of text that starts with “www” or “http://” or is a validly formatted email address like “HelpDesk@hendrix.edu”. These are the same URLs that are recognized in most word processing software such as Word.

To create a hyperlink to an email address or an external website from a piece of text that is not a recognized URL:

1. Select the text or image you want to hyperlink.
2. Click the Insert Link button on the Text Format area of the toolbar.
3. For a regular link, type your link in the box after the “http://”. For a link to an email address, replace the “http://” with “mailto:” without the quotation marks and with no slashes.
To create a link to a content item in the Hendrix website:

1. Select the text or image you want to hyperlink.
2. Click the Insert tab on the Aloha toolbar.
3. Click the library ( ) icon
4. In the right pane of the library, select the type of content you want to link to:
   - Images – Library images
   - Quicklinks – Assets or Content Blocks
   - Forms – Form blocks
   - Files – Library files and images
   - Hyperlinks – We do not use this type of content (or know what it is)
5. In the left pane of the library, you should see the folder list. Navigate to the folder that contains the content you want to link to.
6. You should now see your content in the right pane. Double-click on it to select the content item.

INSPECTOR: HYPERLINKS

If you have the Inspector Window open and click on an existing hyperlink you have several options to change how they behave.

- **Type** – this option lets you more easily insert a link to an email or a bookmark (a link within your content page).
- **Library and Unlink** – You also have access to the library and the “remove link” button in the inspector.
- **Open link in new tab/window** – This is a checkbox that does exactly what it says.

To edit or remove an existing hyperlink:

1. Click on the link you want to edit (you don’t have to select it).
2. Click on the Link tab on the Aloha toolbar.
3. Click the Remove Link ( ) button to delete the link.
4. Re-add the link if you need.

**Figure 15 - Can a page have too many hyperlinks?**

The short answer is “No.”

The long answer is a more complicated “No.”

Many web pages are just links to other pages and serve a valid purpose. That being said if you have a large amount of links, individual links in the list may get ignored. To avoid that you should break up long link lists into sub-lists with headings. If you still think your page looks too cluttered, it probably does, but contact the web team and we can help you with your layout with our special tools and widgets.
TABLES

You shouldn’t use tables. Now skip this section.

...

Okay you’re still reading which *may* mean you have a valid reason to use tables. Tables can serve an important purpose; they provide a grid layout for information that is highly structured and classifiable like scientific data or bus schedules.

They should never be used just to make it easier to arrange your content. If you are having a problem with your layout, contact the HelpDesk.

**To insert a table into your content:**

1. Click where you want the table to appear in the content editor.
2. Click the “Insert Table” button and a grid should appear.
3. Drag the cursor over rows and columns to choose the size of the table.
4. Click the mouse to insert the table into your content.

Working with tables in the Aloha editor can be difficult. If you are having problems, please contact HelpDesk@hendrix.edu so we can convince you not to use tables. I mean so we can help you get your content laid out properly.

If you have more questions about working with tables, use the help tab or the context-sensitive help (🔧).

---

**Figure 16 - Is using tables really that bad?**

When you use tables on a web page it implies a certain role for the content inside of it.

In a regular web browser that might not cause any problems beyond resizing issues (which are a serious problem with the new website’s design for mobile devices), but in a screen reader for a vision impaired person the table will be interpreted very differently. The screen reader will interpret the table as a collection of facts and figures regardless of what you put in it which can cause a great deal of frustration. Seriously, just don’t do it.
INSERTING IMAGES

Pictures on a web page are very important. They break up text and can give your viewers something to identify with or a graphical illustration of what you are trying to convey. We will go over uploading images in a later section, and for now will concentrate on using them in content.

To insert an image into your content (the awesome way):

1. Find the image you want to upload. You should resize it to something reasonable first, obviously.
2. Click and drag the image into your open content editor where you want it to appear.
3. Sing and dance while it says “uploading” at the top of the screen.
4. You are finished.

To insert an image into your content (the long way):

1. Click where you want the image to appear in the content editor.
2. Click the Insert tab on the Aloha toolbar.
3. Click the library ( ) icon
4. In the right pane of the library, select the type of content you want to link to:
   a. Images – Library images
   b. Quicklinks – Assets or Content Blocks
   c. Forms – Form blocks
   d. Files – Library files and images
   e. Hyperlinks – We do not use this type of content (or know what it is)
5. In the left pane of the library, you should see the folder list. Navigate to the folder that contains the content you want to link to.
6. You should now see your content in the right pane.
7. Double-clicking on the image or the file name above it will insert that image at full-size into your content.
8. If you click on the icon to the right of the picture, you will instead insert a small thumbnail that when clicked will open the full-size picture in a new window.

Figure 17 - Should I resize pictures in the content editor?

All these leading questions...

No, you should always resize your images before you upload them to the server. If you resize them in the content editor you are just changing how large they are displayed on the page. A 10 megabyte picture will still take forever to download to the browser as well as anger most mobile users. If you have questions about editing images, please contact HelpDesk@hendrix.edu and we’ll get you squared away.
WRAPPING TEXT

If your picture is relatively small, you may want to align the image to the left or right and wrap the text of your content around it. We recommend using our styles to do this and not just using the text alignment tools to do this.

To align an image and wrap text around it:

1. Open the Inspector Window (the what?)
2. Click on the image to select it. You should see light blue border appear around the image.
3. In the “Css Class” box, type exactly one of the following: “contentImageRight” or “contentImageLeft”.

To remove an image alignment:

1. Open the Inspector Window (the what?)
2. Click on the image to select it. You should see light blue border appear around the image.
3. Click “Reset Styles” at the bottom of the inspector window.

---

Figure 18 - Why use the class names instead of the text-alignment tools for image alignment or the cool things I found in the “Advanced” tab you didn’t talk about?

By using the classes you allow us to more easily adapt your content to the changing style of the Hendrix website.

If we consistently use these classes to align the image, the web team can make changes that affect all of them instantly without having to edit each piece of content directly.

---

PUBLISHING CONTENT

Now that you’ve created a piece of content it is time to make it available to be viewed on the website. Before you set it live, though we need to go over content states.

CONTENT STATES

Content can exist in several states, but there are really only three that you should see.

- **Available (A)** – The content is checked in and is available for anyone with permission to edit it. The content is also the live version on the website.
- **Checked in (I)** – The content is checked in and is available for anyone with permission to edit it. The content is NOT the same version as the live version on the website.
- **Checked Out (O)** – The content is currently checked out exclusively by someone. If you have it checked out you can edit it, otherwise the user that checked it out must check it back in.
SAVING AND PUBLISHING YOUR CONTENT

On the content editor menu above the content title there are several buttons. The big one to know about and use is the “Publish” button.

- “Publish” – save the content you are editing, check it in for others to edit, and make it available on the live website. This sets the content’s status to “A”.

The other options are:

- “Cancel” – Closes the editor. If you have checked out a piece of content it remains checked out to you (“O”) and any changes you have made are not saved. If it was a new piece of content, the content is discarded.
- “Undo Checkout” – Closes the editor. If you have checked out a piece of content, it is rolled back to its previous state and any changes you have made are not saved. If it was a new piece of content, the content is discarded.
- “Check In” – Closes the editor, checks in the content (“I”) and saves your changes. The changes are not made live on the website.
- “Save” – Saves your changes but does not close the editor.

APPROVAL CHAINS

Most content on the website is set up where anyone who has permission to edit a piece of content also has permission to make it the live version of the content on the website. The system has the ability to set up approval chains if they are needed. We don’t recommend this though as it adds extra time to your publishing process. If you are interested in setting up approval chains on some or all of your content, contact the HelpDesk.
VIEWING CONTENT ON THE WEBSITE

Publishing your content does not necessarily mean that anyone will be able to access it. Unless you have created links on menus or other pages the only way someone will get to your page is through directly typing in the address or using the Hendrix site search (if the content is searchable). To view your content before you create a link to it, you need to get the “ID” number for the content you have created. It is in the “ID” column when you are viewing a folder in Ektron.

To view how content will look on your template:

1. Go to your site’s homepage within the Web site.
2. After the address that appears in the address box at the top of the page, type “?id=” and then the ID number of the content block you’d like to view. The ID number is listed in the third column of the folder view in the content tab of the workarea.
3. Press “Enter” to view the content on your template.
4. For example, if you wanted to view the content block called “Student Life” with ID number 179, you would enter the following into the address box:
   http://www.hendrix.edu/studentlife/studentlife.aspx?id=179
5. If you want to view what a form would look like follow the directions above except use “?ekfrm=“ instead of “?id=“.

UPLOADING IMAGES AND FILES

In order to put links to documents and files and to put images on your content items you must first upload the files or images to the Ektron system. There are two different ways to do this, and which way you use depends on the type of file or image you are working with.

DIFFERENCE BETWEEN ASSETS AND LIBRARY ITEMS

There are two different types of media items in the system: Assets and Library Items. The primary difference between the two is that assets can be standalone pieces of content and library items cannot.

When in doubt upload the file as an asset.

Assets are uploaded to the system and a piece of content is created that is associated with the item. Because of this you can do almost anything you can do to a regular piece of content including setting a summary or an alias for it and making it searchable in the Hendrix site search. Additionally because they are content, they can be moved to a different folder if you ever re-organize your folders. Good examples of assets are any type of document, pictures from events, or videos. We recommend that most images, multimedia, and all files (pdf, doc, xls, etc.) be uploaded as assets.

Library items are simple images or files that are uploaded to the system. They cannot be searched, managed, or moved. We recommend using assets for images that cannot be considered standalone content.
To upload a file as an asset:

1. Go to the content tab of the workarea and find the folder you want to upload the file to.
2. Click the “Add Assets” button to open the upload page.
3. Click “Browse…” and select your file from your system.
4. Click “Upload” to upload the file.

To upload a file to the library (the long way, see the awesome way above):

1. Go to the library tab of the workarea and find the folder you want to upload the file to.
2. Click the “Add” button on the right pane to open the “add library item to folder” screen.
3. Enter a title for the image.
4. Select a file from your computer with the “Browse…” button.
5. Enter a summary in the summary box.
6. Click “Save” to upload the file.

Editing a content block is very similar to creating it.

To edit a content block:

1. Click “Content” on the top left to open the content tab.
2. Use the folder list to find the folder where the content you want to edit is located.
3. Once you are in the folder, click on the title of the content you want to edit.
4. Click the “Edit” button to open the content editor.

---

**Figure 19 – Can I upload a 30 megapixel, 4 GB image for my webpage?**

Why would you do that to someone’s cell phone data plan?

Always resize your images before you upload them to the server. If you resize them in the content editor you are just changing how large they are displayed on the page and are not affecting the actual size of the picture.

A 10 megabyte picture will still take forever to download to the browser as well as anger most mobile users and whomever pays their phone bill.
Figure 20 - What if I don’t see an “Edit” button on the menu in the right pane?

If you don’t see an “Edit” button, there are few things you should check.

First, check the status of the content item. If the content is checked out ("O") by another user, they will have to check it in before you can edit it. If the person who has it checked out can’t check it in contact the web team and we can force check it in for you. Please make sure to check with the person who has it checked out first though as this can delete any changes they are currently making if they have not been saved.

If the content is not checked out and you can’t edit it, you may not have permission to edit content in this folder. Check to see if you can edit any other content in the folder, and if not contact the web team to get your permissions updated.
WORKING WITH FORMS

Forms blocks are very similar to content blocks. Let’s dive right in and create one.

CREATING FORM BLOCKS

Creating a form block:

1. Logging in
2. Click “Content” on the top left to open the content tab.
3. Use the folder list to find the folder where you want to create your form.
4. Once you are in the folder you want to create your content in, click “New” → “HTML Form/Survey” in the menu in the right pane to create a new form block.
5. This will open the “New Form Wizard”.

NEW FORM WIZARD

Step 1 of the “New Form Wizard” will ask you to pick a form template to start with. These templates are pre-built forms that you can base your form or survey on to save time. Click on the “Preview” button if you want to view a sample of the form in a new window. If none of the templates fit your need you can create a blank form (the first option).

Step 2 asks you to enter a title and description for your new form.

Step 3 allows you to set up tasks. If you use this option a task in the Ektron system will be created whenever someone fills out the form and is assigned to the user you select.

Step 4 you decide what response you want the user to see when someone fills out the form. There are several options:

- **Display a message** – Displays the message you enter to the user when the form is filled out
- **Redirect to a file or page** – Takes the user to another piece of content in the system. You can use this to create a common page for several forms to redirect to.
- **Redirect form data to an action page** – This is an advanced option that can be used by IT to build a special handler for the data in your form
- **Report on the form** – Allows you to create charts or graphs to display the form results. This is useful for surveys and polls.

Step 5 is the completion step. Click “Done” to be taken to your form to edit it.

USING THE FORM EDITOR

Once you have completed the form wizard you can being editing your form. The form editor is very similar to the content editor, but it has an extra bar with fields that you can place in your form. These controls will allow you to get specific information from your users.
TEXT FIELD

The text field is the most common field on a form. They allow a user to enter text into a box that can optionally be validated for specific criteria.

To insert a text field:

1. Click on your form where you want to insert the text field.
2. Click the “Text Field” button. This should open the “Text Field” properties window.
3. Enter a “Descriptive Name” in the appropriate box. This is the name that will appear in emails and reports for this form. The “Field Name” box will automatically update. **Do not change the field name value.**
4. (Optional) You can change the “Tool Tip Text” to display any instructions for the form field. It will appear when a user hovers over the field.
5. (Optional) You can enter a “Default Value” that will automatically fill the field when it is first loaded.
6. Select the options you want for the text field.
7. Click “OK” to insert the text field.

OPTIONS

There are several options that will allow you to change how the Text Field works.

- **Allow multiple lines** – This makes the text box larger and allows the text to wrap in the box for longer entries. This is often used for short answer type questions.
- **Cannot be changed** – This makes the text field unable to be edited by a user. You can use this if you want to pre-populate a field with a certain value that the user cannot change, such as an event name. This is not often used.
- **Invisible** – This makes the text field invisible to the person filling out the form. It is not often used.
- **Password Field** – This makes the text field display small circles or asterisks in the text box when a user types information into it to prevent others from seeing the entry. It is not often used.

VALIDATION

The validation tab allows you to set rules for your text field. There are several commonly used validation rules, though you can build more complex ones. For information on the custom validation, see the help tab in the workarea. Some of the commonly used validation rules are:

- **Cannot be blank** – This is the simplest validation and ensures only that something is entered in the field.
- **Email address** – This requires that the entry be a validly formatted email address. It has two options, “required” which requires an entry and “or blank” which only validates the field if something is entered into the box.
- **Telephone Number (US and Canada)** – This requires that the entry be a valid US and Canada phone number. It has two options, “required” which requires an entry and “or blank” which only validates the field if something is entered into the box.
CHOICES FIELD

A choices field allows a user to select one or more values from a list provided by the form creator. This can be displayed on the form in several different ways, depending on the options selected.

To insert a choices field:

1. Click on your form where you want to insert the choices field.
2. Click the “Choices Field” button. This should open the “Choices Field” properties window.
3. Enter a “Descriptive Name” in the appropriate box. This is the name that will appear in emails and reports for this form. The “Field Name” box will automatically update. Do not change the field name value.
4. (Optional) You can change the “Tool Tip Text” to display any instructions for the form field. It will appear when a user hovers over the field.
5. Select the options and appearance you want for the field.
6. Choose the items you want the user to be able to select.
7. Click “OK” to insert the choices field.

ITEM LIST

You must enter the items a user can choose from in the choices field. There are several pre-defined lists available in the choices field (Countries, U.S. States & Territories, etc.) You can also enter the items in your list manually.

To add items to the item list of a choices field:

1. In the “Choices Field” properties window, go to the section of the “General” tab labeled “Item List”.
2. For each item in your list, enter a value in the “Display Text” field. This is what the user will see in the choices field.
3. For each item in your list, enter a value in the “Value” field. This is what the system uses to record the selection. It should be a short value with no special characters. No one will see this value on the form or reports.
4. (Optional) Choose whether the item is selected when the form is loaded by using the “Selected” check box.
5. (Optional) Choose whether the item is a valid selection with the “Disabled” check box.
6. To add another item, click the blue plus sign.

You can insert, move, duplicate, and remove list items by clicking on the item menu next to each item.

OPTIONS

There are several options that affect how a choices field is displayed and how a user can interact with it.

- **Appearance** – Choosing an appearance for your choices field affects what selection options are allowed.
- **Allow selection** – “Only one” or “More than one” determines how many items can be chosen. “A selection is required” ensures that a choice is selected. “First item is not a valid selection” is used with Drop Lists to make sure that a user chooses one of the items in the list instead of leaving it in its default state.
CHECKBOX

A check box is a field used for a single yes or no question.

To insert a checkbox field:

1. Click on your form where you want to insert the checkbox field.
2. Click the “Checkbox Field” button. This should open the “Checkbox Field” properties window.
3. Enter a “Descriptive Name” in the appropriate box. This is the name that will appear in emails and reports for this form. The “Field Name” box will automatically update. **Do not change the field name value.**
4. (Optional) You can change the “Tool Tip Text” to display any instructions for the form field. It will appear when a user hovers over the field.
5. Choose whether the checkbox is initially checked when the form is loaded by selecting “true” or “false” in the “Default value” field.
6. Enter a caption for the checkbox. This is the text that will appear to the right of the checkbox on your form.
7. Click “OK” to insert your checkbox field.

VALIDATION

There are two simple validation options for a checkbox field:

- **Must be checked** – The field must be checked to submit the form.
- **Must be unchecked** – The field must be unchecked to submit the form.

CALENDAR

The calendar field is used to simplify entry of dates for forms.

To insert a calendar field:

1. Click on your form where you want to insert the calendar field.
2. Click the “Calendar Field” button. This should open the “Calendar Field” properties window.
3. Enter a “Descriptive Name” in the appropriate box. This is the name that will appear in emails and reports for this form. The “Field Name” box will automatically update. **Do not change the field name value.**
4. (Optional) You can change the “Tool Tip Text” to display any instructions for the form field. It will appear when a user hovers over the field.
5. (Optional) You can enter a “Default Value” that will automatically fill the field when it is first loaded. Click the calendar to the right of the box to select your value.
6. Click “OK” to insert your calendar field.

VALIDATION

There are a few validation options for the calendar field:

- **Date in the past** – The date has already happened. This is good for birthdays and similar data.
• **Date in the future** – The date has not yet happened. This validation is good for appointments and similar data.

**BUTTONS**

When the form is created it will have a submit button. If you accidentally delete the submit button, or if you want to add a button to clear the form data you have the option to do that.

**To insert a “submit” or a “reset” button:**

1. Click on your form where you want the button. Generally this is at the end of the form.
2. Click the “Submit Button” (_sender:submit_button:image|) button or the “Reset Button” (_sender:reset_button:image|) button to insert your button.

**EDITING FORM FIELDS**

**To modify a field’s properties after you have created it:**

1. Click on the form field to select it. You should see 8 small squares at the compass points of your field (that’s the corners and the middle of the sides).
2. Right-click on your field and select “Field Properties...” to open the field’s properties.

**EDITING THE POST BACK MESSAGE**

If you want to edit the form’s post back message after you create the form, you can click on the “Post back message” tab. This will allow you to change any of the options you set in step 4 of the form wizard as well.

**PUBLISHING A FORM**

Once you have finished editing your form, you can publish it exactly like content items. Now that the form is build, you have to set its form properties so that the system knows what to do with data submitted to the form.

**SETTING THE FORM PROPERTIES**

If you make no changes to the form’s properties the system will simply record all data submitted to the form in the database. You can view that data using the reports feature detailed below.

**To edit a form’s properties:**

1. Open the folder containing the form in the workarea.
2. Click on the form so that you are viewing it in the right-pane.
3. Click the “Edit Properties” (_sender:edit_properties:button:image|) button to open the form’s properties.

This is where you can change a form’s title and description, as well as selecting what should happen to the information a user submits.

• **Mail** – sends an email when the form is submitted. See [Mail Properties](#) below for more information.
- **Database** – stores a user’s entry in the Ektron database. It can be viewed later using the [system reports](#).
- **Autofill form values** – pre-fills a user’s information if they are logged in to the Hendrix website and they have filled in the form before.
- **Limit submissions** – limits the amount of submissions to the number entered in the box. This requires users to be logged in to the website.

### MAIL PROPERTIES

If you selected “Mail” as an option in the “Form Data” field, an email will be sent whenever the form is submitted. You can use this to send confirmation messages or to email you when someone enters data in your form.

**Figure 21 - How can I send an email to someone who submits a form? What if I want to make sure the email’s “from” address is the person who submitted the form?**

If you put a text field in your form and gave it the “Email address (required)” validation rule, you can select the form field’s name from a drop down list in the mail properties. This allows you to send the email to the email address entered, make the email from the address entered, or to carbon copy (CC) the email address entered.

- **To** – the email address to send the email message to.
- **From** – the email address that this message will be sent from. This doesn’t have to be a real address, but it must be validly formed (something@something.com, noreply@hendrix.edu, etc.)
- **Cc** – an email address to copy this message to.
- **Subject** – The subject of the email message.
- **Preamble** – Text you want to appear before the email’s form data.

### REPORTS

If you selected “Database” as an option in the “Form Data” field, the information stored is saved in the Ektron database and can be viewed as a report or downloaded as an Excel document.

**To view the form results report:**

1. Open the folder containing the form in the workarea.
2. Click on the form so that you are viewing it in the right-pane.
3. Click the “Report” button to open the report window.
4. (Optional) update the “Start Date” and “End Date” to narrow the amount of results you are viewing.
6. Click “Get Report” to view the report.

**To Export the report as an Excel document:**

1. Adjust the report options until the data is formatted like you want to export it.
2. Click “Get Report” to view the report.
3. Scroll to the bottom of the report and click “Export Report”.

---

Created by Hendrix College
Last updated September 18, 2014
VIEWING FORMS ON THE WEBSITE

To view how a form will look on your template:

1. Go to your site’s homepage within the Web site.
2. After the address that appears in the address box at the top of the page, type “?ekfrm=” and then the ID number of the form block you’d like to view. The ID number is listed in the third column of the folder view in the content tab of the workarea.
3. Press “Enter” to view the form on your template.
4. For example, if you wanted to view the content block called “Student Life” with ID number 179, you would enter the following into the address box:
   http://www.hendrix.edu/studentlife/studentlife.aspx?ekfrm=179
WORKING WITH FOLDERS

Content in the Ektron system is organized into folders for convenience. These folders don’t change the navigation of the website but will allow you to keep related content together for editing. Additionally, permissions are generally based on folders and inherited by the content and sub-folders inside them.

To create a folder:

1. Navigate to the folder you want to create a new folder inside.
2. Click “New”  “Folder”.
3. Enter a “Name” for the folder in appropriate field.
4. Don’t change anything else unless you know what you’re doing.
5. Click “Add Folder” to create the folder.

This new folder should inherit all of the information from the parent folder including templates, permissions, and other options.

Figure 22 - What if I don’t see a “New” button on the menu in the right pane or there is no “Folder” option on the “New” menu?

If you don’t see a “New” button, you may not have permission to create folders in this folder. Contact the web team for more information.

To delete a folder or move content to a new folder:

1. Contact the HelpDesk. Please don’t try to do this yourself.

Figure 23 - What happens if delete a folder?

Lots of screaming and crying.

If you delete a folder, all of the content inside of it is irretrievably destroyed.

We can get it back from our database backups if you inform us quickly enough, but we may or may not be able to restore them depending on how it will affect the rest of the website. PLEASE make sure you read and understand every message you receive from the system ESPECIALLY if it is a confirmation.
MENUS

Menus allow build navigation for your website.

**Figure 24 - When do changes to menus show up on the website?**

All changes to menus are updated on the website immediately. There are no publish states for menus.

You probably cannot edit your own menu.

In version 8.5 Ektron removed the option of giving content editors permission to edit their own menus. This is because most of their customers used one massive site menu instead of many small ones like we do. We are currently creating a workaround to give menu editing control back to the people, but it is not yet ready to go live.

Until we get our menu editor working, you will have to submit your menu update requests to HelpDesk@hendrix.edu for the web team to update for you. We are sorry for the inconvenience.

MENUS ON THE HENDRIX WEBSITE

The menus you will be editing generally show up on the “Section Menu” part of a Hendrix webpage. The style of menus on the Hendrix website is tightly controlled to ensure that they work properly at all monitor sizes, including mobile browsers.

Pages in the Hendrix website generally have the option for two menus. The primary menu which is the large items at the top of the Section Menu which is a full, hierarchical menu and the secondary menu which is a smaller, flat menu that appears below the primary menu.

If you have a need for a special menu, please contact the HelpDesk.

VIEWING YOUR MENUS

To view your menu:

1. Click the “Menus” button on the bottom left of the workarea.
2. Find your menu in the menu list.
3. Click on your menu to open the top level. The menu navigator should open your menu so that you can see your submenus in the left-pane.

ADDING ITEMS TO YOUR MENU

There are four different types of menu items that can be added to your menu.
To add items to your menu:

1. **Open your menu**.
2. Click the “Add Items” button.
3. Choose a menu item type.
4. Enter the options for your menu item type.
5. Click “Add” or “Save” depending on the menu item type and the item will be added to your menu.

**EDITING YOUR MENU ITEMS**

Once you have added items to your menu, you can change the title displayed on the link as well as several other options.

To edit your menu items:

1. **Open your menu**.
2. Navigate to the item you want to edit.
3. Click on the item you want to edit.
4. Update its properties.

To re-order the items on a menu or sub menu:

1. **Open your menu**.
2. Navigate to the menu or sub menu you want to re-order.
3. Click on the “Re-order” (_dragar) button to open the menu item re-order window.
4. Click an item you want to move, then use the up and down arrows to move it to its new position.
5. Repeat as necessary
6. Click “Update”
ADVANCED CONTENT

There are several forms of content that the HelpDesk has put together to allow you to quickly build complex displays of structured content or smart forms. Here are some examples of advanced content.

Figure 25 - Can I use <fill in the blank advanced content item> on my website?
Yes, but you must first contact the web team as each of these special content types requires additional configuration before it will work on your site.

CALENDARS

We have a smart form and special folder combination that allows you to create complex calendars and event lists that will allow users to view events on a monthly calendar as well as download a calendar reminder for Outlook or other calendar programs.

Figure 26 - Do web calendar events show up on the Master Calendar? Do Master Calendar events show on my web calendar?
The Master Calendar system is a separate system from the website and does not interact with the web calendars in any way. It is up to you to make sure that your events are scheduled on the Master Calendar. The web calendars simply give you a nice way to display information about your events on your webpage.

In order to use a calendar on your site, the HelpDesk must set up a special template for you. Please contact them to get your calendar folder set up.

To add a calendar event to your calendar folder:

1. Click “New” → “Add Calendar Event” in your calendar folder.
2. Enter your “Title”, “Location”, and “Description” in the appropriate fields.
3. Update the “Start time” and “End time” for you event.
4. (Optional) Configure a recurring event on the “Recurrence” tab by checking “Recurrence” and selecting the appropriate options.
5. Click “Save” at the bottom right of the event editor.

To edit an existing event on your calendar:

1. Find your event using the calendar in the bottom of the right-pane in your calendar folder.
2. Double-click on your event. If this is a recurring event it will ask if you want to edit the series or just this occurrence.
3. Your event should open for editing.
To delete an event from the calendar:

1. Find your event using the calendar in the bottom of the right-pane in your calendar folder.
2. Mouse over your event on the calendar. You should see a red “X” appear to the right of the event.
3. Click the red “X”.
4. Confirm that you want to delete the event by clicking “OK”.

BLOGS

Blogs are a special type of folder that is ordered by the date a content item was created. Additionally the items in a blog all have the ability to allow viewers to comment on the content items.

To create a new post in your blog folder:

1. Click “New” → “HTML Post” in your blog folder.
2. Create your blog post just like you would any other content item.

COMMENT STRATEGIES

The primary strength of blogs lies in the ability to accept user comments. There are several options for how this is configured on your site, each with its own strengths and weaknesses.

ANONYMOUS, UNAUTHENTICATED COMMENTING

This comment strategy doesn’t require users to log in or provide any information to comment. This is the easiest method for viewers of your site, but the hardest to control. It generally draws spammers and rudeness.

AUTHENTICATED COMMENTING

This comment strategy requires users to log in before they can comment and records their information when they comment. This strategy has the most accountability for offensive posting but requires more work from your viewers.

ANONYMOUS OPTION, AUTHENTICATED COMMENTING

We have also created a new strategy for commenting that requires users to log in to the system and prevents outside spam but doesn’t record any information about the user submitting a comment unless they choose to identify themselves.

MODERATION

No matter which method you use it is likely that you will want to monitor your comments to ensure that no one is posting material you do not want on your blog. The system has the ability to require all comments to receive approval before they go live on the website. This requires more work on the front end for the blog moderator but prevents questionable material from ever getting posted on your blog.
HIGHLIGHTS

Another special type of comment is the highlight. This is a small piece of structured content that has a Title, Message, Image, and an optional link. An example of this type of content is the content in the “Info for future students” box on the homepage.

This content is easy to put together and can be put on most web pages.

COLLECTIONS

Collections are similar to menus, but do not have multiple levels and can only be constructed from content blocks, form blocks, and assets. An example of a collection on the website is the “News & Events” section of the homepage.

Collections are useful for highlighting individual pieces of content in your site on your home page.

Collections are easy to add to most web pages.

AUDIO / VIDEO

Use YouTube. 😊